
SKILLSCOMMONS ACCESSIBILITY 
CHECKPOINTS

METHODS FOR PDF FORMAT
(NONASSISTIVE TECHNOLOGIES)



Accessibility Checkpoints

1. Accessibility 
Documentation

2. Text Access

3. Text Adjustment

4. Reading Layout

5. Reading Order

6. Structural 
Markup/Navigation

7. Tables

8. Hyperlinks

9. Color and Contrast

10. Language

11. Images

12. Multimedia

13. Flickering

14. STEM

15. Interactive Elements



How to access texts

STEPS:
1. Visit Cool4Ed eTextbook Reviews site @ 

http://www.cool4ed.org/reviews.html



How to access texts

STEPS:
1. Visit Cool4Ed eTextbook Reviews site @ 

http://www.cool4ed.org/reviews.html
2. Select desired titles
3. Search for preferred formats
4. Download text

http://www.cool4ed.org/reviews.html


How to access texts

STEPS:
2. Select desired titles



How to access texts

3. Search for preferred format and download text



Formats

Online texts are available in 
various formats and should be 
evaluated based on the following 
rankings:

1. EPUB3
2. HTML
3. Microsoft Word 
4. PDF



Formats

In other words, EPUB3 is ideal, 
but if it is not available, we 
move down the list and search 
for the next available format

4. Download textbook or open 
link (if applicable) (HTML)



Formats

Note: This is an OpenStax 
text. Although EPUB3 isn’t 
listed, it is available!

To determine if there is an 
EPUB3 format for OpenStax 
texts, additional navigation is 
required.



How to access texts

From the “Web View” select “Get This Book!”



How to access texts

Now you can download the EPUB file!

Note: At the time of this writing, only 

OpenStax texts have been found to 

need additional navigation. All other 

texts have been found to clearly list 

out all available formats.



Checklist

All information obtained from textbook evaluation will be entered 
into checklists:



Checklist

For every book, enter the following:
• Content area
• Name of book
• Format (i.e., EPUB, HTML, Word, or PDF)
• OS used (e.g., Microsoft; Windows)
• For EPUB, Word, and PDF formats: Total number of pages 

(obtained from Word or PDF format preferably, if available)
• For HTML only: Total number of chapters 

Note: Only Windows 

will be used for 

analysis until Apple 

equivalents are 

decided upon.



Checklist

Example for the EPUB format of Introductory Statistics (PDF 
version has 863 pages)

Select content type 

from dropdown list

Enter name of 

book in its entirety

Select format and OS – note: each 

format has a different checklist
Only for HTML

https://openstaxcollege.org/textbooks/introductory-statistics/get


Checklist

Note: When certain information is entered such as the number 
of pages or number of chapters, certain information in the 
checklist is updated: 



Checklist

This information is based upon predetermined values for the 
amount of information that needs to be evaluated. You only 
need to round up to the next page count (or link count).

173 pages

87 pages

87 pages

173 pages

173 pages



Checklist

The percentages used are included in this presentation, but that 
is only for your reference – the checklist will fill out this 
information for you!

173 pages

87 pages

87 pages

173 pages

173 pages



Skills Commons Accessibility Checkpoints

All information obtained from textbook evaluation will be entered 
into the checkpoints document:

Enter info 

such as the 

pages you 

evaluated 

here as well.



Pass, Fail, or N/A?

• Evaluate material based on the amount of material 

included in the checklist

• Example: Evaluate 10 links for flickering

7 / 10 links - PASS

6/10 links - FAIL

N/A cannot be used here!



• Ratings are on a scale of 1-10

Ratings

1 5 10

Fail Pass

• Failure to meet a checkpoint (Fail) should not be rated 

above a 7

• Meeting a checkpoint (Pass) should not be rated below a 7

7

|



PDF



PDF Evaluation Requirements

OS 
• Windows OS (XP or above)

Require Downloading
• Adobe Acrobat Pro XI or DC (DC: Download, $449)

• Color Contrast Analyzer- CCA (Download)
** Following screenshots are done with Adobe Acrobat Pro XI

https://acrobat.adobe.com/us/en/pricing/pricing.html?cmpgn=sembrandbuy&sdid=KARFP&skwcid=AL!3085!3!70518882862!e!!g!!adobe acrobat %2Bpro&ef_id=VRLvXwAABYOznjX8:20150721152628:s
http://www.paciellogroup.com/resources/contrastanalyser/


1. Accessibility Documentation

For the textbooks’ organizations, find the following:
☑URL to formal Accessibility Policy
☑URL to accessibility statements
☑URL to Accessibility Evaluation Report



Accessibility Documentation: Checkpoint 1 parts A, B, and C

Pass =  

There was a URL address found for the formal accessibility policy/accessibility 

statement/accessibility evaluation report. Adobe Acrobat Pro XI/DC and Google Chrome 

were used to access and evaluate this text.

Fail = 

There was no URL address found for the formal accessibility policy/accessibility 

statement/accessibility evaluation report. Adobe Acrobat Pro XI/DC and Google Chrome 

were used to access and evaluate this text.



2. Text Access

☑The text of the digital resource allows the user to 
enable text-to-speech (TTS) functionality 

◉ Amount of Material to Be Evaluated

*** Sample 5 pages ***



STEPS:

1. Open file with Adobe Acrobat XI Pro

2. View > Read Out Loud > Activate

3. Select Read This Page Only when you are on the 

page you would like to evaluate.

2. Text Access



4. The text content should be read in a manner that is clear and 
understandable to the listener.

5. If elements of the text are not read adequately take that into 
account when scoring this checkpoint

6. Base your score off of the amount of passing material

2. Text Access

◉ Amount of Material to Be Evaluated
*** Sample 5 pages ***



2. Text Access



Text Access: Checkpoint 2 Text to Speech

Fail = 

0/5 pages pass for text to speech. Pages 10, 150, 250, 350, and 400 were used for this 

checkpoint. The read-out-loud function did not read text and states that the page was 

empty. Adobe Acrobat Pro XI and the Read Out Loud function were used to access and 

evaluate this text.

Pass =

5/5 pages pass for text to speech. Pages 10, 150, 250, 350, and 400 were used for this 

checkpoint. All pages were successfully read using the read-out-loud function. Adobe 

Acrobat Pro XI and the Read Out Loud function were used to access and evaluate this 

text.



3. Text Adjustment (Size)

☑The text allows the user to adjust the font size

• Check text size between the range of 50% to 200% 
zoom

• Do not check for text reflow in this checkpoint



3. Text Adjustment (Size)

STEPS:

1. Open file with Adobe Acrobat XI Pro

2. Edit > Preference >Accessibility

3. Select Always use Zoom Setting > Reflow (drop down)

4. Click OK

5. CLOSE Adobe Acrobat Pro

6. Open the file with Adobe Acrobat Pro again

7. Zoom in and out to see if the text adjust its size to fit the screen 

(Take into account sections that are cutoff when scoring)

8. Remember to deselect Always use Zoom Setting > click ok > close 

and reopen the file (to keep everything in original format for the rest 

of the evaluation)



3. Text Adjustment (Size)

◉ Amount of Material to Be 
Evaluated

*** Sample 5 pages ***



Text Adjustment: Checkpoint 3 A, Compatible (Size)

Fail = 

0/5 pages pass for text size adjustment. Pages 15, 115, 215, 315, and 415 were used for 

this checkpoint. Text size was able to be adjusted between 75% to 200% zoom on all 

pages; however, text size was not able to be adjusted below 75% zoom. Adobe Acrobat 

Pro XI was used to access and evaluate this text.

Pass = 

5/5 pages pass for text size adjustment. Pages 15, 115, 215, 315, and 415 were used for 

this checkpoint. Text size was able to be adjusted between 50% to 200% zoom on all 

pages. Adobe Acrobat Pro XI was used to access and evaluate this text.



3. Text Adjustment (Color)

☑The text allows the user to adjust the font/background 
color



STEPS:

1. Open file with Adobe Acrobat XI Pro

2. Edit > Preference >Accessibility

3. Select Replace Document Colors > Green text on Black (drop 

down)

4. Click OK

5. Sometime you must go to the next page for the change to take 

place

6. Remember to deselect Replace Document Colors > click OK > 

close and reopen the file (to keep everything in original format for 

the rest of the evaluation)

3. Text Adjustment (Color)



3. Text Adjustment (Color)

◉ Amount of Material to 
Be Evaluated

*** Sample 5 pages***



Text Adjustment: Checkpoint 3 B, Adjust font and colors

Fail = 

0/5 pages passed font and color adjustment. Pages 8, 108, 208, 308, 408 were checked 

and failed. The text color was adjusted but a portion of the background remained a light 

color. Adobe Acrobat Pro XI was used to access and evaluate this text.

Pass = 

5/5 pages passed font and color adjustment. Pages 8, 108, 208, 308, and 408 were 

checked and passed because text color was adjusted and the background was darkened. 

Adobe Acrobat Pro XI was used to access and evaluate this text.



4. Reading Layout (reflow)

☑Text of the digital resource allows the user to reflow the 
text by specifying the margins and line spacing

Check text size between 50% to 200% zoom

◉ Amount of Material to Be Evaluated

*** Sample 5 pages ***



4. Reading Layout (reflow)
STEPS:

1. Open file with Adobe Acrobat XI Pro

2. Edit > Preference >Accessibility

3. Select Always use Zoom Setting > Reflow (drop down)

4. Click OK

5. CLOSE Adobe Acrobat Pro

6. Open the file with Adobe Acrobat Pro again

7. Zoom in and out to see if the text reflows

8. Remember to deselect Always use Zoom Setting > click ok > 

close and reopen the file (to keep everything in original format for the rest 

of the evaluation)



◉ Amount of Material to Be 
Evaluated

*** Sample 5 pages ***

4. Reading Layout (reflow)



Reading Layout: Checkpoint 4 A, Reflow the Text

Fail = 

0/5 pages pass for reflow of the text. Pages 15, 115, 215, 315, and 415 were used for 

this checkpoint. All evaluated pages failed because horizontal scrolling was required at 

115% zoom and above. Adobe Acrobat XI Pro was used to access and evaluate this text.

Pass = 

5/5 pages pass for reflow of the text. Pages 15, 115, 215, 315, and 415 were used for 

this checkpoint. All evaluated pages had proper text reflow without the use of horizontal 

scroll bars when text was resized from 50% to 200% zoom. Adobe Acrobat XI Pro was 

used to access and evaluate this text.



4. Reading Layout (# of pages)

☑ If the digital resource is an electronic alternative to 
printed materials, the page numbers correspond to the 
printed material 

**Mark this checkpoint with N/A, we don’t have the 
printed version of the text**



Reading Layout: Checkpoint 4 B, Page # match printed 

material & reflow of text

N/A = 

We do not have access to the printed version of this text. Adobe 

Acrobat XI Pro was used to access and evaluate this text.



5. Reading Order

☑Reading order for digital resource content logically 
corresponds to the visual layout of the page when 
rendered by text to speech functionality

◉ Amount of Material to Be Evaluated

*** Sample 5 pages ***



5. Reading Order

STEPS:

1. Open file with Adobe Acrobat XI Pro

2. Locate 5 pages ( include page # in the reports) that 

contain a more complicated layout

3. Use the Read Out Loud function to check if the reading 

order is logical (please refer to checkpoint #2 for 

instructions on Read Out Loud)

◉ Amount of Material to Be Evaluated

*** Sample 5 pages ***



Reading Order: Checkpoint 5, Digital Resource Layout

Fail = 

0/5 pages pass reading order for digital resource layout. Pages 16, 72, 83, 129, and 241 

were used for this checkpoint. All pages failed because the Read Out Loud function 

would start reading the main text and then skip to content in the margins or to figures 

before returning to the main text. Adobe Acrobat Pro XI and the Read Out Loud function 

were used to access and evaluate this text.

Pass = 

5/5 pages pass reading order for digital resource layout. Pages 16, 72, 83, 129, and 241 

were used for this checkpoint. All evaluated pages pass because the Read Out Loud 

function read text content in a manner that corresponded to the visual layout of the page 

without skipping content. Adobe Acrobat Pro XI and the Read Out Loud function were 

used to access and evaluate this text.



6. Structural Markup / Navigation

Part A: Navigation Text

☑ The text of the digital resource includes markup (e.g. tags or 
styles) that allows for navigation by key structural elements 
(chapters, headings, pages) 

☑ Results: Check for Tagged PDF, Title, Bookmarks, and Headings

☑ Include the ratio of passing content and score accordingly



6. Structural Markup / Navigation
• Adobe Acrobat Pro: Accessibility Checker

1. Open the file in Adobe Acrobat Pro XI

2. Select Accessibility Tools 



3. Select Full Check.
6. Structural Markup / Navigation



4. Select the Start Checking button to begin the full check.
6. Structural Markup / Navigation



Results: Check for Tagged PDF, Title, Bookmarks, and Headings
6. Structural Markup / Navigation



Structural Markup: Checkpoint 6 A, Navigation Text

Fail = 

1/4 accessibility criterion pass structural markup for text navigation. A full accessibility 

check in Adobe Acrobat XI Pro indicated that the text passed for bookmarks, but failed 

for title, tagged PDF, and headings. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 

Pass = 

4/4 accessibility criterion pass structural markup for text navigation. A full accessibility 

check in Adobe Acrobat XI Pro indicated that the text passed for bookmarks, title, tagged 

PDF, and headings. Adobe Acrobat XI Pro was used to access and evaluate this text. 



Part B: Lists

• The text of the digital resource 

includes markup for bullets and 

numbered lists

• Results: Check for both

1. List Items

2. Lbl and Lbody

• Include ratio of passing content and score  according to manual check

6. Structural Markup / Navigation



Structural Markup: Checkpoint 6 B, Lists

Fail = 

0/10 lists pass for structural markup. Lists were found on pages 2, 3, 5, 11(2), 12, 13, and 24(3). All lists were 
unable to be read using the Read Out Loud function in Adobe. A full accessibility check in Adobe Acrobat XI 
Pro indicated that lists failed for both list items and lbl and Lbody. Adobe Acrobat XI Pro and Read Out Loud 
were used to access and evaluate this text.

Pass = 

10/10 lists pass for structural markup. Lists were found on pages 2, 3, 5, 11(2), 12, 13, and 24(3). All lists, list 
items, and numbers were read by the read out loud function within Adobe. A full accessibility check in Adobe 
Acrobat XI Pro indicated that lists pass for both list items and lbl and Lbody. Adobe Acrobat XI Pro and Read 
Out Loud were used to access and evaluate this text.

7/10 lists pass for structural markup. Lists were found on pages 2, 3, 5, 11(2), 12, 13, and 24(3). For passing 
content, all list items, and numbers were read by the read out loud function within Adobe. Failing lists were 
the three lists found on page 24 and they failed because the individual list items could not be read. A full 
accessibility check in Adobe Acrobat XI Pro indicated that lists pass for both list items and lbl and Lbody. 
Adobe Acrobat XI Pro and Read Out Loud were used to access and evaluate this text.



Part C: eReader Application

☑ If the text of the digital resource is delivered within an ebook 
reader application, a method is provided that allows users to 
bypass the reader interface and move directly to the text content 
that is compatible with assistive technology 

6. Structural Markup / Navigation

**Mark as N/A: We are not using an additional e-reader 
application for this evaluation**



Structural Markup: Checkpoint 6 C, eReader Application

N/A = 

We are not using an additional eReader application in this evaluation. 

Adobe Acrobat XI Pro was used to access and evaluate this text.



7. Tables

☑Data tables include markup (e.g. tags or styles) that 

identifies row and column headers

☑Results: Check for Rows, TH and TD, Headers, and 
Regularity

☑ Include the ratio of passing content but score according 
to your manual check



7. Tables
• Adobe Acrobat Pro: Accessibility Checker

1. Open the file in Adobe Acrobat Pro XI

2. Select Accessibility Tools 



3. Select Full Check.
7. Tables



4. Select the Start Checking button to begin the full check.
7. Tables



Results
7. Tables



7. Tables
• Additional Manual Check

STEPS:

1. Select a table in the text

2. Activate the read-out-loud function (please refer to 
Checkpoint #2)

3. Use the read-out-loud function to read the current page 
(Shift + Ctrl + V)

4. Repeat the steps to check for 5 tables 

*** Sample 5 tables ***



Table Markup: Checkpoint 7, Table Markup

Fail = 

0/5 tables pass for table markup. Tables were found on pages 27, 40-41, 63, 86, and 102-103. All tables 
evaluated were not able to be read by the read out loud function within Adobe. The full accessibility check 
within Adobe indicated that 4/4 criteria passed. Tables passed for Rows, Th and TD, Headers, and Regularity. 
Adobe Reader XI Pro was used to access the text for this evaluation.

Pass = 

5/5 tables pass for table markup. Tables were found on pages 27, 40-41, 63, 86, and 102-103. All tables were 
able to be read by the read out loud function within Adobe. The full accessibility check within Adobe indicated 
that 2/4 criteria passed. The passing criteria were Rows and Th and TD, while the failing criteria were 
Headers and Regularity. Adobe Reader XI Pro was used to access the text for this evaluation.

4/5 tables pass for table markup. Tables were found on pages 27, 40-41, 63, 86, and 102-103. All passing 
tables were able to be read by the read out loud function within Adobe. The single failing table was found on 
page 41-42. Text content within the failing table was jumbled and Read Out Loud would skip cells. The 
accessibility checker tool within Adobe indicated that 2/4 criteria passed. The passing criteria were Rows and 
Th and TD, while the failing criteria were Headers and Regularity. Adobe Reader XI Pro was used to access 
the text for this evaluation.



8. Hyperlinks
☑Functionality: Links (e.g. website or email addresses) within the 

text of the digital resource are rendered as active hyperlinks in a 

manner that allows them to be detected (using the tab key) and 

activated (using the enter key)

☑Check that the link redirects to the correct location

☑If the link does not redirect when the enter button is clicked then fail 

this sub category

☑If the link is not accessed when using the tab and enter key then fail 

this sub category



☑Descriptive: The link is descriptive enough for the users to know 

where the link will take them. 

☑If the link appears as an URL = fail this sub category.

☑Check both within-book links and live hyperlinks for both 

functionality and descriptiveness

8. Hyperlinks



8. Hyperlinks (in-book)
• Adobe Acrobat Pro: Accessibility Checker

1. Open the file in Adobe Acrobat Pro XI

2. Select Accessibility Tools 



3. Select Full Check.
8. Hyperlinks (in-book)



4. Select the Start Checking button to begin the full check.
8. Hyperlinks (in-book)



Results
8. Hyperlinks (in-book)



8. Hyperlinks (in-book)

◉ Amount of Material to Be Evaluated
*** Sample 30 in-book links ***
10 from the beginning of the book
10 from the middle of the book
10 from the end of the book

Ex. Links that takes you to a certain chapter

Check for descriptive links when going 
through each link manually. 

1. Check for Navigation links in Results

2. Manual check

• Score according to the manual check 

results



Hyperlinks: Checkpoint 8, Within-book Hyperlinks

Fail = 

15/30 within book links pass for functionality and 0/30 within book links pass for 

descriptiveness. Links were found on pages 5(6), 19(3), 47(4), 65(8), 93(4), and 106(5). The 

links on pages 5, 47, and 106 failed functionality because they were not active and could not 

be selected using the tab and enter key; All links were non-descriptive because they were 

single words or numbers. The full accessibility check indicated that navigational links passed. 

Adobe Acrobat XI Pro was used to access and evaluate this checkpoint.

Pass = 

30/30 within book links pass for functionality and descriptiveness. Links were found on pages 

5(6), 19(3), 47(4), 65(8), 93(4), and 106(5). All links could be selected using the tab and enter 

key and were descriptive enough to inform the user regarding the location to which they would 

be taken. The full accessibility check indicated that navigational links passed. Adobe Acrobat 

XI Pro was used to access and evaluate this checkpoint.



8. Hyperlinks (Live)

STEPS:
Use Tab key to navigate through links 
> Press enter when you find a live 
hyperlink (Check for functionality and 
descriptive link at the same time)

◉ Amount of Material to Be Evaluated
*** Sample 20 website hyperlinks ***

Hyperlink that takes you somewhere outside of the book
Ex. Links to a live website



Hyperlinks: Checkpoint 8, Hyperlink Functionality (Live)

Hyperlink (Live on Internet) = 
This is a combined average of the following two subsections (functionality and descriptiveness). Adobe Acrobat 
XI Pro was used to access the text for this evaluation and Google Chrome was used to access the links online.

Hyperlink Functionality (Live) = 

Pass = 
20/20 live links pass for hyperlink functionality. Pages 1 through 99 were used for this checkpoint. Passing links 
were found on pages 1(15), 65(3), and 99(2). All links were able to be selected using both the "Tab" and 
"Enter" keys and redirected to the correct locations. Adobe Acrobat XI Pro was used to access the text for this 
checkpoint and Google Chrome was used to access the links online.

Fail =
0/20 live links pass for hyperlink functionality. Pages 1 through 99 were used for this checkpoint. Failing links 
were found on pages 1(15), 65(3), and 99(2). None of the links could be accessed using the tab key. Adobe 
Acrobat XI Pro was used to access the text for this checkpoint and Google Chrome was used to access the links 
online.



Hyperlinks: Checkpoint 8, Hyperlink Descriptiveness (Live)

Hyperlink Descriptiveness (Live) = 

Pass = 

20/20 live hyperlinks pass for descriptiveness. Links were found on pages 79(6), 140(4), 146(3), 
and 149(7). All evaluated links clearly describe the location to which they redirect the user. 
Adobe Acrobat XI Pro and Google Chrome were used to access and evaluate this text.

Fail = 

13/20 live hyperlinks pass for descriptiveness. Links were found on pages 79(6), 140(4), 146(3), 
and 149(7). Passing links clearly describe the location to which they redirect the user. The failing 
links were all found on page 149 and are in the form of a URL address. Adobe Acrobat XI Pro and 
Google Chrome were used to access and evaluate this text.



9. Color & Contrast (Color Redundancy)

☑ Color redundancy (information is not conveyed by color 
alone) needs to be checked manually 

☑ Consider the amount of failing content in each 
chapter/section when determining the score

◉ Amount of Material to Be Evaluated

*** Sample 5% of the pages ***



Color and Contrast: Checkpoint 9 A, Color Redundancy

Fail = 

0/5 pages pass for color redundancy. Pages 256-261 were used for this checkpoint. The 

evaluated pages were not color redundant for certain text elements such as links. The 

links on each page were only distinguishable from standard text by means of color. 

Adobe Acrobat XI Pro was used to access and evaluate this text.

Pass = 

5/5 pages pass for color redundancy. Pages 256-261 were used for this checkpoint. All 

evaluated pages were color redundant, using alternate means of distinguishing content 

aside from color. This includes underlining links in the text and providing texture patterns 

for color sections of a graph. Adobe Acrobat XI Pro was used to access and evaluate this 

text. 



☑ The visual presentation of text and images of text in the digital 
resource has a contrast ratio of at least 4.5:1 

STEPS:
1. Download Colour Contrast Analyzer Tool 

2. Open the document you want to evaluate

3. Open the application
4. Make sure you are in the Result --Luminosity mode.

5. Click the Foreground eye dropper tool, hover over and click the 
foreground color to select it.

6. Click the Background eye dropper tool, hover over and click the 
background color.

7. Check and compare the ratio to 4:5:1

9. Color & Contrast (Contrast Ratio)

http://www.paciellogroup.com/resources/contrastanalyser


Color & Contrast (Contrast Ratio)
Colour Contrast Analyzer 
(CCA)
1. Download Colour 

Contrast Analyzer 
Tool 

2. Open the document 
you want to evaluate

3. Open the application

http://www.paciellogroup.com/resources/contrastanalyser


Color & Contrast (Contrast Ratio)
4. Make sure you are in 

the Result --
Luminosity mode.

5. Click the Foreground eye 
dropper tool, hover over 
and click the foreground 
color to select it.



Color & Contrast (Contrast Ratio)
6. Click the Background eye 

dropper tool, hover over 
and click the background 
color.

7. Be sure to be in full screen 
at 100% zoom

8. Determine if the text is 
greater than 18 points (e.g. 
Header).

Small text: Check under “Text”

Large text (18+): Check under 

“Large text”



Reporting Contrast results

When content passes, report the color 

combination but not the ratio:

“The blue text on white background passed.”

When content fails, report the color combination and 

the ratio:

“The blue text on blue background fails with a ratio of 

2:1:1.”



Example Simple Image

When content passes, report the color combination but not 

the ratio:

“The simple image was found on page 45 and the black on 

white background passed with the Colour Contrast Analyzer.”

“The simple image found on page 91 passed with the black 

text on the blue background.”



Color & Contrast (Contrast Ratio)

◉ Provide color combinations for passing and failing 
content

◉ Provide contrast ratios only for failing content
◉ Amount of Material to Be Evaluated

Contrast Ratio

*** Sample 5% of the pages ***



Color and Contrast: Checkpoint 9 A, Headers

Contrast = 
This is a combined average of the following three subsections (Header, Text, and Simple Images). Adobe Acrobat XI Pro was used 
to access the text for this evaluation and the Colour Contrast Analyzer tool was used to determine contrast ratios.

A) Contrast – Headers = 

Pass = 
3/3 Header color combinations pass for color contrast. Pages 5 though 40 were used for this checkpoint. The passing header 
color combinations were black text on a white background, black text on a light green background, and dark blue text on a light 
grey background. Adobe Acrobat XI Pro was used to access the text for this evaluation and the Colour Contrast Analyzer tool was 
used to determine contrast ratios.

Fail =
1/3 Header color combinations pass for color contrast. Pages 5 though 40 were used for this checkpoint. The passing header 
color combination was black text on a white background. The failing header color combinations were light green text on a light 
blue background with a contrast ratio of 1.27:1, and light orange text on a light blue background with a contrast ratio of 1.18:1. 
Adobe Acrobat XI Pro was used to access the text for this evaluation and the Colour Contrast Analyzer tool was used to determine
contrast ratios.



Color and Contrast: Checkpoint 9 B, Text

B) Contrast – Text = 

Pass = 
3/3 Text color combinations pass for color contrast. Pages 5 though 40 were used for this checkpoint. The 
passing text color combinations were black text on a white background, black text on a light green background, 
and dark blue text on a light grey background. Adobe Acrobat XI Pro was used to access the text for this 
evaluation and the Colour Contrast Analyzer tool was used to determine contrast ratios.

Fail =
1/3 Text color combinations pass for color contrast. Pages 5 though 40 were used for this checkpoint. The 
passing text color combination was black text on a white background. The failing text color combinations were 
light green text on a light blue background with a contrast ratio of 1.27:1, and light orange text on a light blue 
background with a contrast ratio of 1.18:1. Adobe Acrobat XI Pro was used to access the text for this 
evaluation and the Colour Contrast Analyzer tool was used to determine contrast ratios.



Color and Contrast: Checkpoint 9 C, Simple Images 

C) Contrast – Simple Images = 

Pass = 
2/2 Simple images pass for color contrast. Pages 5 though 40 were used for this checkpoint. Simple images 
were found on pages 17 and 29. The passing color combinations for simple images was black on a white 
background. Adobe Acrobat XI Pro was used to access the text for this evaluation and the Colour Contrast 
Analyzer tool was used to determine contrast ratios.

Fail =
1/2 Simple images pass for color contrast. Pages 5 though 40 were used for this checkpoint. Simple images 
were found on pages 17 and 29. The passing color combination for the simple image on page 17 was black on a 
white background. The failing color combination for the simple image on page 29 was light green on a light 
blue background with a contrast ratio of 1.27:1. Adobe Acrobat XI Pro was used to access the text for this 
evaluation and the Colour Contrast Analyzer tool was used to determine contrast ratios.



10. Language

☑Part A Markup: The text of the digital resource includes 

markup that declares the language of the content

☑Part B Passage: If the digital resource includes 

passages in a foreign language, these passages 

include markup that declares the language
☑ **Mark Passage Markup as N/A: Adobe Pro XI does not check for 

foreign language**



• Adobe Acrobat Pro: Accessibility Checker
1. Open the file in Adobe Acrobat Pro XI

2. Select Accessibility Tools 

10. Language



3. Select Full Check.

10. Language



4. Select the Start Checking button to begin the full check.

10. Language



Results
10. Language



Language: Checkpoint 10, A – Markup, B – Passage Markup 

A – Markup:

Fail = 

Language markup failed for this text. A full accessibility check was conducted using tools within Adobe Acrobat XI 

Pro. Results indicated that primary language failed. Adobe Acrobat XI Pro was used to access and evaluate this 

text. 

Pass = 

Language markup passed. A full accessibility check was conducted using tools within Adobe Acrobat XI Pro. 

Results indicated that primary language passed. Adobe Acrobat XI Pro was used to access and evaluate this text. 

B – Passage Markup:

N/A = 

Adobe Acrobat XI Pro does not check for foreign languages. Adobe Acrobat XI Pro was used to access and 

evaluate this text.



11. Images
☑Non-decorative images have alternative text that is 

compatible with assistive technology (or is rendered by an 
application such as a browser, media player, or reader that 
offers this functionality) 

☑A non-decorative image is an image that is directly related 
and relevant to the text content



☑Decorative images are marked with null alternate text or 
contain markup that allows them to be ignored

☑Decorative images are images that are not related in any 
way to the content of the text

☑Complex images, charts, and graphs have longer text 
descriptions that are compatible with the text to speech 
functionality

11. Images



Image Examples

Non-Decorative

Adds something to the content 

and can easily be described

Complex

Adds something to the content and 

takes more than one sentence to 

explain

Decorative

Does not add to the knowledge 

gained in a section.



• Adobe Acrobat Pro: Accessibility Checker
1. Open the file in Adobe Acrobat Pro XI

2. Select Accessibility Tools 

11. Images



3. Select Full Check.

11. Images



4. Select the Start Checking button to begin the full check.

11. Images



Results
11. Images



◉ Check manually: Make sure the descriptions for the images 
are descriptive enough for both non-decorative images and 
complex images.

◉ Amount of Material to Be Evaluated for non-decorative and 
complex images:
*** Sample 10 images each***

◉ Rule of thumb: if the image cannot be described in one 

sentence, it’s complex!

11. Images (Additional Manual Check)



Images: Checkpoint 11 A, Non-Decorative Images

Non-decorative images present: 

Pass = 
3/3 non-decorative images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 
12, 45, and 74. There were only three non-decorative images within the evaluated pages. All images have adequate 
descriptions that are sufficiently read using the read-out-loud function. The full accessibility check indicated that the 
figures alternate text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate 
this text.

Fail = 
0/3 non-decorative images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 
12, 45, and 74. There were only three non-decorative images within the evaluated pages. All images lack adequate 
descriptions and alternative text descriptions and are not read using the read-out-loud function. The full accessibility 
check indicated that the figures alternate text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used 
to access and evaluate this text.

Non-decorative images not present: 

N/A = 
There were no non-decorative images found within this text. The full accessibility check indicated that the figures 
alternate text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.



Images: Checkpoint 11 B, Decorative Images

Decorative images present: 

Pass = 
3/3 Decorative images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 12, 
45, and 74. There were only three decorative images within the evaluated pages. All images were skipped and not read 
by the read-out-loud function. The full accessibility check indicated that the figures alternate text failed. Adobe Acrobat 
XI Pro and the Read Out Loud function were used to access and evaluate this text.

Fail = 
0/3 Decorative images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 12, 
45, and 74. There were only three decorative images within the evaluated pages. All images had descriptions  that were 
read by the read-out-loud function. The full accessibility check indicated that the figures alternate text failed. Adobe 
Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.

Decorative images not present: 

N/A = 
There were no decorative images found within this text. The full accessibility check indicated that the figures alternate 
text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.



Images: Checkpoint 11 C, Complex Images

Complex images present: 

Pass = 
3/3 Complex images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 12, 45, 
and 74. There were only three complex images within the evaluated pages. All images have adequate descriptions and 
longer text descriptions that are read using the read-out-loud function. The full accessibility check indicated that the 
figures alternate text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate 
this text. 

Fail = 
0/3 Complex images pass. Pages 1 though 74 were used for this checkpoint. The images were found on pages 12, 45, 
and 74. There were only three complex images within the evaluated pages. All images failed because text descriptions 
were not read or described using the read-out-loud function. The full accessibility check indicated that the figures 
alternate text failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text. 

Complex images not present: 

N/A = 
There were no complex images found within this text. The full accessibility check indicated that the figures alternate text 
failed. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.



12. Multimedia

☑ Part A: A synchronized text track (e.g. open or closed 

captions) is provided with all video content

☑ Part B: A transcript is provided with all audio content

☑ Part C: Audio/video content is delivered via a media 

player that is compatible with assistive technology



12. Multimedia

1. Check for Tagged Multimedia in Adobe 

Accessibility Full Check Results

2. Manual Check for synchronized text and 

transcript.



12. Multimedia

◉ Amount of Material to Be Evaluated

*** Sample a minimum of three videos, if applicable***



12. Multimedia (Text Track)
1. Find multimedia
2. Search for availability of a text track



Multimedia: Checkpoint 12 A, Text Track

Multimedia (Text track) present: 

Pass = 
3/3 multimedia pass for text track. The entire text was used for this checkpoint. Only three multimedia were 
found and they were on pages 48, 97, and 265. All multimedia included a text track that could be enabled by 
the user. The full accessibility check within Adobe indicated that tagged multimedia passed. Acrobat XI Pro 
was used to access and evaluate this text.

Fail = 
0/3 multimedia pass for text track. The entire text was used for this checkpoint. Only three multimedia were 
found and they were on pages 48, 97, and 265. All multimedia failed to provide a text track that could be 
enabled by the user. The full accessibility check within Adobe indicated that tagged multimedia passed. 
Acrobat XI Pro was used to access and evaluate this text.

Multimedia (text track) not present: 

N/A = 
There were no multimedia found within this text. The full accessibility check within Adobe indicated that 
tagged multimedia passed. Adobe Acrobat XI Pro was used to access and evaluate this text.



12. Multimedia (Transcript)
1. Find multimedia
2. Search for availability of a transcript



12. Multimedia (Transcript)



Multimedia: Checkpoint 12 B, Transcript

Multimedia (Transcript) present: 

Pass = 

3/3 multimedia pass for transcript. The entire text was used for this checkpoint. Only three multimedia were found 

and they were on pages 48, 97, and 265. All multimedia included a transcript that could be enabled by the user. 

The full accessibility check within Adobe indicated that tagged multimedia passed. Acrobat XI Pro was used to 

access and evaluate this text.

Fail = 

0/3 multimedia pass for transcript. The entire text was used for this checkpoint. Only three multimedia were found 

and they were on pages 48, 97, and 265. All multimedia failed to include a transcript that could be enabled by the 

user. The full accessibility check within Adobe indicated that tagged multimedia passed. Acrobat XI Pro was used 

to access and evaluate this text.

Multimedia (Transcript) not present: 

N/A = 

There were no multimedia found within this text. The full accessibility check within Adobe indicated that tagged 

multimedia passed. Adobe Acrobat XI Pro was used to access and evaluate this text.



12. Multimedia Assistive Player

☑ Audio/video content is delivered via a media player that is 

compatible with assistive technology

**Mark as N/A: We are not using an assistive player for 
this evaluation**



Multimedia: Checkpoint 12 C, Assistive Player

N/A = 

We are not using as assistive player for this evaluation. Adobe 

Acrobat XI Pro was used to access and evaluate this text.



13. Flickering

☑ Resources should not contain 

anything that flashes more than 

three times in any one-second 

period

***Check for Screen Flicker in Results



Flickering: Checkpoint 13, Flickering

Pass = 

No content was found to flicker during the evaluation of this text. The entire text was used 

for this checkpoint. The full accessibility check within Adobe indicated that screen flicker 

passed. Adobe Acrobat XI Pro was used to access and evaluate this text.

Fail = 

During the evaluation of this text certain content was found to flicker. The entire text was 

used for this checkpoint. Flickering content was found on pages 23, 59, and 72. The 

pages would flash three to four times before displaying the text. The full accessibility 

check within Adobe indicated that screen flicker failed. Adobe Acrobat XI Pro was used to 

access and evaluate this text.



14. STEM

STEM: Science, Technology, Engineering, and Math

☑Markup: STEM content is marked up in a manner that 

is compatible with text to speech functionality

☑Notation Markup: The resource conveys both the 

notation (presentation) and meaning (semantics) of the 

STEM content



STEM Figures

Markup
Markup 

Notation



For BOTH Markup and Notation:

1. Select a STEM content in the text

2. Activate the read-out-loud function (please refer to Checkpoint #2)

3. Use the read-out-loud function to read the current page (Shift + Ctrl 
+ V)

4. Repeat the steps to check for 10 STEM content in each sub-section 

14. STEM

Did read-out-loud 

read this correctly?



Classifying STEM

Remember, the markup will tell you how to 

classify content. If it is marked as Figure, it 

is a Figure. 



☑STEM content is marked up in a manner that is 

compatible with text to speech functionality

STEPS:

1. Manually check that the following have a label, 
description or tag that can be accessed by Read Out 
Loud

• Figures
• Graphs
• Equations
• Tables

14. STEM Markup



14. STEM Markup

The STEM content should have a label, description or tag



This equation would fail for markup (none present), but it could pass for notation mark 

up if it was read correctly using the read-out-loud function in Adobe Acrobat Pro. 

14. STEM Mark-up



STEM: Checkpoint 14 A, Markup

If STEM is present: 

Pass = 

10/10 STEM figures/graphs/equations/tables pass for markup. The STEM figures were found on pages 23(3), 32(2), 

49(1), and 6(4). All figures included a markup that was able to be read using the read-out-loud function in Adobe. 

Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.

Fail = 

0/10 STEM figures/graphs/equations/tables pass for markup. The STEM figures were found on pages 23(3), 32(2), 

49(1), and 6(4). All figures lacked a markup that was able to be read using the read-out-loud function in Adobe. Adobe 

Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this text.

If STEM is not present: 

N/A = 

There were no STEM figures (Tables/Graphs/Equations) found within this text. Adobe Acrobat XI Pro and the Read Out 

Loud function were used to access and evaluate this text.



☑The resource conveys both the notation (presentation) 

and meaning (semantics) of the STEM content

STEPS:

1. Manually check that the following have a text 
description that conveys notation and meaning

• Figures
• Graphs
• Equations/Tables

14. STEM Notation Markup



Manually check that all 
figures, graphs, and 
tables have a description 
that conveys notation and 
meaning

14. STEM



STEM: Checkpoint 14 B, Markup Notation

If STEM is present: 

Pass = 

3/3 STEM figures/graphs/equations/tables pass for notation markup. Only three STEM figures were found within 

the text. STEM figures were found on page 17, 84, and 92. All STEM figures had text descriptions that clearly 

described the STEM content and was able to be read using the read-out-loud function in Adobe. Adobe Acrobat XI 

Pro and the Read Out Loud function were used to access and evaluate this text.

Fail = 

0/3 STEM figures/graphs/equations/tables pass for notation markup. Only three STEM figures were found within 

the text. STEM figures were found on page 17, 84, and 92. None of the STEM figures had text descriptions that 

clearly described the STEM content and all STEM figures were not able to be read using the read-out-loud 

function in Adobe. Adobe Acrobat XI Pro and the Read Out Loud function were used to access and evaluate this 

text.

If STEM is not present: 

N/A = 

No STEM figures (or Tables/Graphs/Equations) were found in this text. This text was viewed using Adobe Acrobat 

Pro.



15. Interactive Elements

☑Keyboard

☑ Interactive elements allow for keyboard-only operation

☑The interactive element can be navigated and accessed 
using the tab and enter key



15. Interactive Elements

STEPS:
• Without assistive technology, use the TAB key to 

navigate the menu
• Items that are selected will have a box around the link 
• Use the ENTER key to select a link or other item



Interactive Element Example

The CSULB Campus Map

Campus structures can be 

navigated through using the 

“Tab” key and selected using 

the “Enter” key



Interactive Elements: Checkpoint 15 A, Keyboard

If interactive elements are present:

Pass = 

1/1 interactive elements pass for keyboard operation. There was only one interactive element found within 

this text and it was on page 52. The interactive element allowed for keyboard only operation using the “Tab” 

and “Enter” keys to navigate and select components. Adobe Acrobat XI Pro was used to access and evaluate 

this text. 

Fail = 

0/1 interactive elements pass for keyboard operation. There was only one interactive element found within 

this text and it was on page 52. The interactive element did not allow for keyboard only operation using the 

“Tab” and “Enter” keys to navigate and select components. The user was required to use a mouse to interact 

with the element. Adobe Acrobat XI Pro was used to access and evaluate this text. 

If interactive elements are not present: 

N/A = 

There were no interactive elements found within this text. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 



☑Markup
Each interactive element conveys information to 
assistive technology regarding the element’s
☑name
☑type
☑status

15. Interactive Elements

**Mark as N/A because this requires assistive technology**



Interactive Elements: Checkpoint 15 B, Markup

If interactive elements are present:

N/A = 

We are not using assistive technology for this evaluation. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 

If interactive elements are not present: 

N/A = 

There were no interactive elements found within this text. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 



☑Text prompts
The following are conveyed with assistive technology:
☑Instructions
☑Prompts
☑Error messages

How to:
Use Tab key to activate the interactive elements and check if you receive any 

text prompts.

15. Interactive Elements

**Mark as N/A because this requires assistive technology**



Interactive Elements: Checkpoint 15 C, Text Prompts

If interactive elements are present:

N/A = 

We are not using assistive technology for this evaluation. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 

If interactive elements are not present: 

N/A = 

There were no interactive elements found within this text. Adobe Acrobat XI Pro was used to access and 

evaluate this text. 


